
WinSpeakerz 95 Demo Manual v1.0

About WinSpeakerz 95 

Welcome to a new generation of loudspeaker design tools!  WinSpeakerz is a 32 bit application written for Windows 95. We've 
taken full advantage of the Windows 95 interface to provide you with a toolbox containing everything you need to design state of 
the art loudspeakers. And it's never been easier!  Among the great new features of WinSpeakerz 95 you now have a Toolbar with 
Tooltips and one step software installation.  

WinSpeakerz 95 can show the designer the precise audio performance that can be achieved by any driver in any number of 
enclosure types.  Beyond enclosure analysis WinSpeakerz 95 provides an advanced array of calculators which allow you to design 
passive crossovers, impedance compensation networks, and attenuators as well as rectangular, trapezoidal, and bandpass cabinets.  
Frequency scale end points are fully adjustable from 1 Hz to 100 kHz.  A preference selection is provided for metric or English 
units.

WinSpeakerz 95 organizes your work in Project files.  Starting with a new Project file the designer opens the Driver Database and 
selects a driver to load to the Workbench.  Back at the Workbench the designer proceeds to look at the performance of the driver in 
various enclosures.  As he works he saves some of the best designs to the System memories.  After saving a couple of Systems 
based on the first driver the user might return to the database to select an alternate driver and then save a few more Systems to 
additional memory locations in the Project file.  

Each Project file holds 10 System memories, each a snapshot of the Workbench containing a complete driver file, full details on the
enclosure, crossover, impedance compensator networks, and detailed notes on the System.  Systems can be instantly recalled to the 
Workbench by clicking the corresponding buttons on the toolbar.  Any combination of saved Systems can be recalled for 
comparison of different drivers in similar enclosures or the same driver in various enclosures.  Clicking the print button on the 
toolbar causes a report to be printed showing the plots just as they appear on screen.  Most of the printed reports display an 
engineering title block with basic Project information.

The Driver Database has a full search and sort capability as well as the ability to tag drivers via keywords.  Each Driver Record is
extremely detailed with provisions for over 90 different driver parameters.  Space is provided for such details as the driver's bolt

circle diameter, front and rear mount baffle cutout diameters and retail price.  A comments field provides full text editing capability
allowing the designer to keep detailed notes on the drivers he uses.  Double clicking on a driver in the database listing brings up the
database Record Editor,  a dialog box with 3 tabbed pages of information on the selected driver.  Selecting the "New Driver" button

creates a new blank record where details on a new driver can be entered.  Driver records can be added, edited and deleted.
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The System Editor is a five page dialog which displays all the information on the System currently on the Workbench.  It has two 
pages of System details as well and three pages of information on the driver.  Each of the 10 System memories contains all five 
pages of information, all of this in a single Project file.

The application keeps track of your most recently used Project files and offers immediate access to these files under the File menu.  
When a Project file is loaded the Workbench is restored just as the user left it.  A preference selection allows the last Project file to 
be recalled automatically to the Workbench when WinSpeakerz 95 is launched. Other advanced features include the ability to have 
several Project files open at once along with a toolbar and such niceties as tool tips and print preview.  

WinSpeakerz 95 can print a number of different reports including sorted lists of drivers you have selected from the database.  

A fully illustrated 200 page manual is included with the fully functional version of WinSpeakerz.  The manual includes a step by 
step tutorial for those new to loudspeaker design. You'll find discussions on Speaker Design Tradeoffs (box size versus efficiency), 
Compliance Ratio, Driver Evaluation in Existing Enclosures, Driver Parameter Measurement, Crossover Design, Designing 
Bandpass Enclosures and more!

1.0 A Tutorial Session with WinSpeakerz
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This Demo version of WinSpeakerz allows the user to explore many features of WinSpeakerz, but only for one driver, the TIA 
Model 8.  You can model various enclosures for this driver in 2nd Order Closed, 3rd Order Closed, 4th Order Vented, 4th Order 
Symmetric Bandpass, 5th Order Asymmetric Bandpass and 6th Order Symmetric Bandpass boxes and save them to the System 
memories.  

- This Demo version cannot save or open Project Files.
- The Driver Database cannot be opened.  
- The Box and Crossover Calculators will not accept numerical input.

Begin this tutorial by launching the WinSpeakerz  Demo.  Once you have launched WinSpeakerz you will see the three windows 
displayed on the screen as shown below.  This trio of windows act as a workbench where you can try out an unlimited number of 
new designs. 

The WinSpeakerz Workbench

The large window at the top is the Response window.  We will also refer to this window as the plot window in this Demo manual.  
This is where the Frequency, Excursion, Phase, Group Delay, and Impedance response plots of the systems you design will be 
displayed.  You can save and recall up to 10 System files to create custom displays and reports.  

The lower left window is the Driver and System Parameters window.  This is where the small signal parameters of the currently 
loaded driver are displayed.  Normally, Driver files can be loaded from the Driver Database by using the Open Driver Database 
command under the File menu.  You can edit an existing driver's parameters or create your own files for new drivers by selecting 
the Edit Record and New Driver buttons in the Driver Database. This tutorial allows you to design with one driver only.

The lower right window is the Box Parameters window. WinSpeakerz  has 6 different Box Parameter windows ranging from the 
2nd Order Closed Box to the 6th Order Bandpass Box listed under the Box menu. The default will be the 2nd Order Closed Box.  
The Box Parameters window is where you will enter the parameters of your proposed closed, vented and bandpass enclosures. 

1.1  Driver Evaluation in Closed Boxes

We will be designing enclosures to deliver predictable frequency response curves with a given driver, the TIA Model 8.  Make sure 
the 2nd Order Closed Box is selected and displayed in the lower right window by selecting it from the Box menu.

The most significant closed box alignments can be found at the end of this Demo manual under Design Aids.  We will use them as 
our guideposts for our closed box design.  Note that you are not restricted to these alignments when you design an enclosure, they 
are intended only as guideposts.

The Frequency and Excursion Responses are always actively selected as a default when you launch WinSpeakerz.  All response 
curves can be toggled off from the toolbar or under the Analysis menu.  For this section of the tutorial toggle off the Excursion 
response so that we can explore the Frequency responses of the enclosures we design. We'll toggle the Excursion response on later 
in the tutorial.
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We will start the closed box evaluation by finding the smallest enclosure that would be of interest for this driver and then explore 
progressively larger boxes.

The smallest useful enclosure for a given driver is usually a closed box with a Qtc of about 1.0. That's because smaller closed boxes
would have Qtc values greater than 1.0 and therefore, would have an excessively peaked frequency response for music 
reproduction.  However, you should explore the high Qtc response curves for your own information.

- Enter the value 1.0. in the Closed Box Q, Qtc field in the 2nd  Closed Box Parameters window

- Note that the program has calculated and displayed the Box Volume of 1.0 cubic feet that corresponds to a closed box  
  Qtc = 1.002 cu ft.

- Select Calc Freq Resp under the Analysis menu. (or use Ctrl+F from the keyboard)

As expected, this response is slightly peaked at 1.5dB.  Note that the F3 or -3dB cutoff, is about 65 Hz.  

Before going any further, we should save this response curve in one of  the 10 System files.

- Select Store workbench in Sys1 under the Display menu.  (or use Alt+1 from the keyboard)

We can extend the bass response by looking at larger boxes.  We'll lower the Qtc and use the Butterworth alignment of .707 to get a
larger enclosure.

The Butterworth alignment gives the flattest and most extended frequency response possible for a closed box speaker system, 
making it the first choice for many designers.  To make the Butterworth alignment with a  Qtc of 0.707, we need a larger box 
compared to the 1.0 cubic feet that is required for the system with  Qtc of 1.0.  As we increase the Volume of the Box, the Closed 
Box Q will fall.

-Enter 0.707 in the Closed Box Q edit field in the Box Parameters window.

The system calculates and displays in the Box Volume edit field the volume required for the Butterworth system: 2.938 cubic feet.  
Note that the box size tripled. Calculate the frequency response and save that response in System 2.

-  Select Calc Freq Resp under the Analysis menu. (or use Ctrl+F from the keyboard)

Wait for the response to be calculated.

-  Select Store workbench in Sys 2 under the Display menu. (or use Alt+2 from the keyboard) 
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Look at the frequency response and you'll see that it makes a  maximally flat Butterworth response.  The F3 has gone down from 
about 65 Hz to 58 Hz and has a usable low end (-10dB) of about 35 Hz.  This would make a good closed box loudspeaker system 
for the TIA Model 8.

Note: The  Qtc of a closed box system can never be less than the Qts of the driver that you are using.  

As we ask for system Qtc's close to the Qts of the driver, the box volume requirement becomes huge.  When we ask for a system 
with Qtc equal to the Qts of the driver, the required box volume is infinite and 0 is displayed in the Box Volume edit field.  Asking 
for a system Qtc which is less than the Qts of the driver causes WinSpeakerz  to display a negative number for the box volume.  
This means that the requested system is not feasible.

For the most accurate transient response from a loudspeaker, you want a low Qtc system.  We recommend closed box Q's in the 
range from Qtc = 0.57 to Qtc = 1.0 with lower being better.

1.2  Saving and Recalling System Files

Now that you have some plots on screen and saved into System files you can try the system save and recall feature.  First, clear the 
Response window.

-Select Clear Display under the Display menu.  (or use Ctrl+E from the keyboard)

 The system clears the plot window display.  Now recall the first of the two plots.

- Select Recall System 1 under the Display menu.  (or simply press the Sys 1 button on the toolbar)  

- Repeat this step to recall System 2.  

Each time you recall a plot from a System file the Box Parameters window will be refreshed with the contents of the file saved for 
that System.  When you save a System file, only the response curves that have been calculated and that you have currently selected 
under the Analysis menu will be saved with that System file.

1.3  Driver Evaluation in Vented Boxes

Now we will explore a vented box response curve for the TIA Model 8 driver.  Select Clear Display from the Display menu. Choose
the 4th Order Vented Box from under the Box menu.

To make a good vented box, you should start with a closed box that has a Qtc no higher than 0.7.  In general, start with a low box 
frequency, say 40 Hz, and increase or decrease the box frequency in about 10 Hz steps until you see the range of responses possible 
for this box volume.  Then, fine tune the best of the responses for the flattest response.  

Select the 4th Order Vented Box from the Box menu.  We will start with a  box Qtc of 0.65and try venting it at 35 Hz.  

-  Enter .65  in Qtc field in the Box Parameters window.
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-  Enter 35 (Hz) at the Box Freq. field in the Box Parameters window.

-  Note that the Min. Vent Area, SvMIN has been calculated and displayed in that field.
   SvMIN = 6.5 sq inches

-  Select Calc Freq Resp under the Analysis menu. (or use Ctrl+F from the keyboard)

You can see that venting the box has extended the low frequency cutoff from 65 Hz for the closed box to 38 Hz for the vented box 
tuned to 35 Hz, but the response has a bit of a peak.

- Save this response in System 3. (or use Alt+3 from the keyboard)
 
We could continue to look at higher box frequencies but they would only result in more peaked responses and higher cutoff 
frequencies.  However, you might try that later as an exercise.

Now that we have completed the design for a vented enclosure we can Open the Vent Calculator. 

We want to choose a vent(s) that will provide the recommended minimum vent area, SvMIN or as close to that as possible.  Open 
the Vent Calculator and you'll notice that WinSpeakerz has recommended  using 2 two inch diameter tubes. The vent surface area is
6.283 sq inches and each vent would be cut to 1.251 inches in length. 

Save the contents of the Box Parameters window to System 3 to store the vent information.

1.4  Using the Phase, Group Delay, Excursion and Impedance Response Functions

Phase Response

Let's take the box that we have stored in System 3 and turn on the phase response.  This can be done by looking under the Analysis 
menu and choosing Phase Response or, use the toolbar icon.  Now do a Ctrl+G to clear and recalculate.  You see the frequency and 
phase responses appear along with a new phase scale on the left side of the screen.  The phase scale is calibrated from 0 degrees to 
360 degrees in 30 degree increments.  Each grid step is 30 degrees.

Group Delay Response

Let's turn on the Group Delay function by choosing Group Delay Response from under the Analysis window.  Now enter Ctrl+G 
from the keyboard to see this new curve added to the screen.  Notice a new scale at the right side of the screen showing the Group 
Delay of this system in milliseconds. 

Group delay is the delay of the signal from the system electrical input to the speaker's acoustic output. 

Let's set the Group Delay scale to 30 milliseconds under the Analysis menu.  The display is redrawn at the new scale.  

Let's turn off the Phase and Group Delay Responses and look at Frequency and Excursion.  Use the toolbar icons to toggle Phase 
and Group Delay off.
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Excursion Response

Turn the Excursion Response on, either from the toolbar or from the Analysis menu.  Calculate the response by doing a Ctrl+G.  

You can see that the excursion scale is calibrated in millimeters at the right side of the screen.  The default scale goes from 0 to 15 
millimeters.  You can choose the appropriate scale for a given driver.  Under the Edit Driver window we can see that the xmax, or 
Max Peak Displacement of the TIA Model 8 driver is about 9 millimeters.  

WinSpeakerz gives you information on both the linear excursion and mechanical excursion limits of the driver.  Linear Excursion is
the nominal xmax that manufacturers quote on their drivers. It's the furthest the cone can travel without distortion. Specifically, it's 
the furthest the cone can travel without the voice coil beginning to come out of the gap.  Linear excursion is how far it can travel 
without distorting. 

The Mechanical Excursion limit is how far the cone physically travels before it hits a mechanical stop.  When it hits the mechanical
limit it causes a loud, unpleasant noise.  There is some risk the driver will be damaged when it hits the mechanical limit. 

The Maximum Thermal Power, Pt, is the manufacturers full rated specification and can be found on the Driver: Parameters tabbed 
page in the Database Record Editor.  We can see that the excursion of this driver at its full rated power, 300 watts, stays well within
its excursion limit. In fact, you could drive it harder without violating its excursion limit.  This driver would be a good candidate for
electronically assisted bass extension because its excursion is so conservative.

You can view the excursion response of a system at any power level you wish by changing the P(in) in the Driver and System 
Parameters window.  You may want to derate the system in cases where the excursion limit is violated. 

Impedance Response

The impedance of a loudspeaker varies with frequency. The Impedance scale is displayed at the right side of screen in ohms.  
Calculate the response by doing a Ctrl+G

The peaks that you see represent resonances of the vented box enclosure.  Notice that between the two peaks there is a minimum in 
the response.  The minimum vented box impedance falls at the box frequency.  The FB in our enclosure falls at 55 Hz.  The 
minimum impedance therefore falls at the same frequency.

The excursion response has its minima at the same place as the impedance response.  As you vary the FB of the enclosure you'll see
the impedance peaks vary.  Classical 4th order Butterworth alignments will have impedance peaks that are equal in height.  A 4th 
order Butterworth response results from the following alignment:

driver Qts  = .383 
VB = .707 Vas
FB = fs

1.5  Creating and Saving a Speaker Project File
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A Speaker Project File consists of up to 10 System files. System files include the driver(s), a collection of various boxes and their 
response curves.

Up to this point we have talked about how to take a given driver, the TIA Model 8, and find different boxes with various frequency 
responses for that driver. Now, let's save that driver and the frequency responses that you have created as a Speaker Project File.

- Select Edit System from the Edit menu

- Notice that the System: Details page displays the name of the System File,  Demo Speaker Project 1.  
  The tabbed pages of the System Editor include:

- System Details
- System Notes
- Driver: General Information
- Driver: Parameters
- Driver: Physical and Mounting Information

On these pages you can change the volume of the box under test, or the box resonance frequency.  All the parameters from the Box 
Parameters windows are saved as part of the Speaker Project File plus any system notes that you might want to enter on the System:
Notes page.  The tab key will scroll you through the various edit fields as well as your up and down cursor keys.   

You may want to create a system that consists of optimum enclosures for various size boxes for a particular driver, and then save 
that system.  When you design with that driver, recall that file and it will already have saved and displayed for you proposed system
responses for different size boxes.              

- Close the System Editor window by clicking on its close box at the top right

This will take us back to the Response window.  

- Print your report by doing a Ctrl+P. 

The print command will allow the user to print a normal report for the TIA Model 8 driver.  Included in the printout is an expanded 
listing of the parameters shown in the Driver Parameters window, the contents of the Box Parameters window, and the System 
parameters.

2.0 The WinSpeakerz Windows:

The Response Window

This is the top window of the Workbench where the predicted Frequency, Excursion, Impedance, Phase and Group Delay 
Responses will be displayed.  It normally shares the screen with the Driver Parameters and Box Parameters windows below but you 
can maximize the Response window to fill the entire screen for increased resolution. 

The Driver and System Parameters Window

The bottom left window displays the basic parameters and gives the SPL (Sound Pressure Level) for any number of drivers at any 
input power and any listening distance.  The complete list of driver parameters is shown in the Driver Editor window. 

  
The Box Parameters Window

The bottom right window is where you describe the box type you want WinSpeakerz to analyze.  

2.1 The WinSpeakerz Menus:

Following are detailed descriptions of each menu command.  Commands are arranged  in the same order as they appear across the 
menu bar on the screen.
2.2  The File Menu Commands:

The File menu is the first menu to the right of the apple menu.  The commands under the File menu are as follows:
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New

Selecting New clears all system and driver edit fields as well as clearing the contents of all 10 memories. The Response window 
title reverts to "Untitled Subsystem" until a new subsystem is loaded or a new system name is entered from the System Editor 
window.  (from the keyboard use Ctrl+N)
  
Open 

Brings up a standard dialog window and allows you to load a previously saved Speaker Project file.  (Disabled in the Demo 
version).

Save 

Saves the current Speaker Project file.  (from the keyboard use Ctrl+S) 

Save As...

Brings up a standard dialog window and allows the current Speaker Project file to be saved under a new name or to a different disk. 

Open Driver Database...

In the fully functional version, WinSpeakerz brings up a standard dialog window and allows a Driver file from the Driver database 
to be loaded.  This feature is not available in the Demo version.

Print Preview

Brings up a picture of what you're page will look like. 

Page Setup...

Displays the printer setup dialog to be displayed.

Print...

Brings up a print dialog box and prints a standard report on the current Speaker Project file.  The report contains the currently 
displayed frequency response plots including all driver parameters and system parameters.  The report also includes the date and 
time printed.  (from the keyboard use Ctrl+P)

Close Window

Closes the System Editor, Driver Editor and various calculator windows.  (from the keyboard use Ctrl+W)

MRU (Most Recently Used)

WinSpeakerz keeps track of your most recently used Project files and offers immediate access to these files under the File menu.  
When a Project file is loaded the Workbench us restored  just a s the user left it. A Preference selection allows the last Project file to
be recalled automatically to the Workbench when WinSpeakerz is launched.

Exit

Exits the application. (from the keyboard use Ctrl+Q)

2.3  The Edit Menu Commands:  

Undo
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Select Undo to go back in step your work.

Cut, Copy, and Paste

These standard functions can be used to cut, copy and paste among the edit fields.

Edit System

This command brings up the System Editor window.  The System Editor is a five page dialog which displays all the information on 
the System currently on the Workbench.  It has two pages of System details as well and three pages of information on the driver.  
Each of the 10 System memories contains all five pages of information, all of this in a single Project file. System information 
consists of:

- the name of the system
- the number of identical drivers sharing the enclosure 
- box volume 
- box frequency 
- the box loss, Q(B)
- compliance ratio 
- the complete driver file 
- the contents of the 10 System files 
- vent information 
- notes about the System

From the keyboard use Ctrl+A.  

Preferences

Selection is provided for metric or English units in the Preferences window.  You can also select the file WinSpeakerz will open 
with. There are 4 choices for the plotting background. 

2.4 The Analysis Menu Commands:

Calculate Response

Selecting this menu item tells the system to calculate and plot the responses that have been selected under the Analysis menu.  Plots
already on the screen will remain.   (from the keyboard use Ctrl+F) 

Clear & Calculate Response

This command has the same effect as Calculate Response except the screen is cleared before the new response is plotted.  (from the 
keyboard use Ctrl+G)  

The Loudspeaker Response Functions

Frequency Response
Excursion Response 
Phase Response (2nd Order Closed and 4th Order Vented boxes only)
Group Delay (2nd Order Closed and 4th Order Vented boxes only)
Impedance Response (2nd Order Closed and 4th Order Vented boxes only)

The Loudspeaker Response menu items toggle on and off each time you select the menu item.  Select once to turn  the response on 
and select it again to turn it off.  When a response is turned on WinSpeakerz will calculate and plot selected responses for the 
current driver and box combination when the calculate command is given. 

dB SPL Mode

WinSpeakerz has two choices for the frequency response scale: 0 dB Mode and dB SPL Mode.  SPL, or Sound Pressure Level is a 
measure of the perceived loudness of sound.   While the 0dB scale is normally used to quickly locate the -3dB and -10dB 
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frequencies on the response curve, the dB SPL scale is useful for showing how loud the speaker can play at full power, or at any 
power level you enter in the P(in) field of the Driver and System Parameters window.  This feature is especially useful where it is 
necessary to derate the system power below the maximum thermal power rating of the driver in order to avoid violating the 
excursion limit of the driver in a particular enclosure.  

When you open the WinSpeakerz application the default SPL distance is 1 meter.  Enter values either in meters  or feet.  When you 
enter one the other is calculated automatically and the SPL scale is recalculated to reflect that new distance.  When you're in the 
SPL mode the screen will redraw whenever you enter a new value in one of these fields.  The SPL can be predicted for any 
Distance, D, any Number of Drivers, N, and at any subsystem Input Power level, P(in).

dB Per Division

You have a choice of five different dB per division settings.  You can set the vertical scale to display either .5, 1, 2, 3, or 5 dB per 
division.  The 1dB step allows for a high resolution plot or you can see a more course resolution plot of the frequency response at 3 
dB. The default setting is 2 dB per division.  The .5 and 5 dB  settings allow you to zoom in to see detail or to zoom out to gain 
perspective.

Delay Range
Excursion Range 
Impedance Range

Choose the scale for each Range.  The default settings are shown by a checkmark. 

2.5 The Display Menu Commands:

Clear Display

Use this command to clear the Response window.  Note:  stored Systems are not cleared by this command, only the display window
is cleared.  Build a display for printing by clearing the display and then recalling only those Systems you wish to print.  The printed 
report contains only those response curves displayed when the print command is given. Use the Redraw command to see which 
curves will be printed. (From the keyboard use Ctrl+E) 

Redraw

Causes the display to be cleared and the last calculated response to be redrawn.  Any displayed system files are also redrawn.  
(From the keyboard use Ctrl+R)

Store System

Saves the current response in the selected System file with its corresponding box information. Displays the System number at the 
top of the tool bar.

Saving System Files: The contents of the 10 System files are saved to disk as part of each Speaker Project File.  The System files 
are saved only when the Speaker Project File is saved.  Loading a Speaker Project File causes the System files to be restored.

These commands are used to save up to 10 response plots in the 10 System memories.  The contents of the memories are saved  to 
disk as part of the users Speaker Project file.                                              

Show/Hide Systems

The Show/Hide commands are used to display up to 10 System files.  The contents of the System files are saved to disk as part of 
the user's Speaker Project File.  When a System is recalled the relevant information appears in the Box Parameters window, filling 
in the edit fields with the information previously saved for that System .

You can recall a System and then put that recalled response in another System.  For example, you can recall System 1 and save it to
System 9.  When you recall a response it becomes the active response in the Box Parameters window and that System response is 
available to be saved to any other System file.
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Be aware that you can only save those responses to System files that are turned on under the Analysis menu and have been 
calculated.  When you want to transfer between System files, if you've got all 5 responses calculated then you'll want to turn them 
all on and move them all at once.  Otherwise there will be no information saved for those responses.

Clear System

Permanently deletes the current System file for the Project

High Freq Limit
Low Freq Limit

The variable high-low frequency limits allows you to zoom out and see the loudspeaker response in perspective with respect to the 
entire audio bandwidth or to look closely at a narrow band for greater detail.  You may want to set the limits to 20 Hz and 20k Hz to
see the response of the woofer system in perspective to the complete audio system.  The user can set the Low Freq Limit anywhere 
from 1 Hz to 10k Hz and the High Freq Limit from 10 Hz to 100k Hz.  

Toolbar

Displays icons that you can use to do various functions such as printing and recalling System files. We recommend using the 
toolbar icons as a shortcut to the menu commands.

Status Bar

Toggles the Status Bar off and on.

2.6  The Vent Calculator

The Vent Calculator has tabbed pages for Tube Vents and Rectangular Vents.  The Vent Calculator will recommend the number 
and diameter of tubes based on the Minimum Recommended Vent area, SvMIN in the Box Parameters window. Or, enter the 
desired diameter and number of tubes and the vent surface area and length of each tube will be calculated.

For Rectangular Vents enter the vent height, vent width and desired number. The vent surface area and length of the vent will be 
calculated.

2.7  The Box Menu 

WinSpeakerz has 6 different box types corresponding to 6 different Box Parameters windows: 2nd Order Closed, 3rd Order Closed, 
4th Order Vented, 4th Order Bandpass, 5th Order Bandpass, and 6th Order Bandpass. Holding down the Alt key as you select from 
the Box menu prompts WinSpeakerz to suggest volumes and tunings for each box type. 

The Rectangular, Trapezoidal and Bandpass box calculators are also located under the Box Menu and on the Toolbar. There are 
input fields for Driver Displacement, Bracing Displacement, Other Displacement and Box Volume added by filling.  The 
WinSpeakerz manual, generously illustrated, goes into much greater detail about each of these features. 

In addition to calculating the volume from arbitrary enclosure dimensions, WinSpeakerz  will calculate the dimensions from the 
volume.  You can enter box dimensions and the box volume will be calculated, or you can enter a volume and WinSpeakerz will 
calculate the dimensions using the golden ratio. The Box Calculators have locks in each of the box dimension fields for holding 
certain dimensions constant while allowing other dimensions to float. In the Demo version the dimensions have default settings 
which cannot be changed.

The Trapezoidal Box Calculator includes an angle field to specify the angle of the side of the enclosure.  The default is 15 degrees 
when you first open the trapezoidal box calculator.  WinSpeakerz takes the V(B) from the Box Parameters window and calculates 
the dimensions for a 15 degree trapezoidal enclosure according to the golden ratio. 

2.8  The Crossover Menu

WinSpeakerz has six types of crossover calculators: 1st, 2nd, and 3rd Order Butterworth, 2nd and 4th Order Linkwitz and 1st Order 
Series with adjustable damping.  They all operate in the same manner with the user entering the impedances of the tweeter and 
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woofer and specifying the crossover frequency.  The WinSpeakerz Crossover Menu includes a Resonance Compensator Calculator, 
Inductance Compensator Calculator (Zobel) and a Tweeter Attenuator Calculator.  These calculators have default entries that 
cannot be changed in this Demo version. 

2.9 The  Window Menu

Arranges the windows by cascading, tiling or by icon.  Shows the selected window.

3.0 Design Aids

Closed Box Alignments

Q(tc) = 1.0 This response corresponds to the smallest box of interest.  It has a slightly peaked response.

Q(tc) = 0.707 This is a Butterworth alignment which has the flattest possible amplitude response.

Q(tc) = 0.577 This corresponds to a Bessel alignment which has the flattest possible delay response (most linear phase 
response).

Q(tc) = 0.50 This corresponds to a Critically Damped alignment in which the step response has no overshoot.  It requires the 
largest box.

3.1 Additional Information:  

- WinSpeakerz will show you the range of possible responses for a driver.  Turn on those responses you'd like to see from the 
toolbar. Enter a 0 in the Box Volume field, VB,  followed by Ctrl+F.

- The On/Off status of each response is shown under the Analysis menu by the checkmark at the left of the menu item.  Only those 
responses that are selected are actually calculated.  The Frequency and Excursion responses are tuned on as a default when you   
WinSpeakerz.

- WinSpeakerz can model isobarik (sometimes called "compound") enclosures.  Enter "1" for the number of drivers in the System 
Editor window.  Enter "2" for the Isobarik Factor. 

- You have two choices for the Frequency Response.  You can choose between 0 dB Mode and dB SPL Mode which can tell you 
the dB SPL (loudness) of the proposed system.  

Ordering Information:  

True Image Audio
349 W. Felicita Ave., Suite 122
Escondido, California  92025
Telephone: 800-621-4411
Intl. Phone & Fax: 619-480-8961

WinSpeakerz 95 v1.0 is $299.00
Next Day shipping add $15.00
2nd Day shipping add $5.00
International shipping add $15.00

We accept Visa/MasterCard or send a check or Money Order made payable to True Image Audio. 
California residents add 7.25% ($21.68) sales tax.
Educational discounts are available for students and instructors. 
For international orders, checks must be US Funds drawn on a US Bank.

We offer a 30 Day Money Back Guarantee!
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